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1.1. What is FishStatJ 

FishStatJ is a desktop application to disseminate statistical data to users; in particular FAO Fishery 

Statistical data. 

It started in the early 1990’s, with the first release of FishStatPlus which was designed to run on 

DOS; used to disseminate Fishery statistical datasets for download and on CD-ROM. At the CWP 

(Coordinating Working Party on Fishery Statistics) meeting in 2005 the limitations of the DOS-

based FishStatPlus were discussed (details: http://www.fao.org/fishery/topic/18238/en). 

With the release of Windows Vista; it was clear that an upgrade was needed, and development of 

the next generation FishStatJ started in 2008. The name FishStatJ was selected, because FishStatJ is 

developed using Java technology. At the 23rd CWP meeting (2010) the prototype of FishStatJ was 

endorsed for full development; and the first release of FishStatJ was delivered in 2011. 

FishStatJ was designed to improve on the features of FishStatPlus: 

 All Fishery reference data is available (all FAO code lists with all attributes) 

 All hierarchies are available (for view, and for filtering/aggregation) 

 Graphing and charting functions of FishStatPlus are included 

 Calculated columns of FishStatPlus are included 

 The software is cross-platform (Windows, Macintosh, LINUX)  

 Data (workspaces) of dimensions can be defined as needed (flexible) 

 Any data with fixed dimensions and yearly resolution can be loaded 

For the creation of workspace files (database files); a separate software called FishStatJ Console 

was developed. 

 

In order to use the statistical data, the user has to download and install the FishStatJ application 

on his computer (more details follow). 

http://www.fao.org/fishery/topic/18238/en
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1.2. Installing on Windows 

Download the Windows application http://www.fao.org/fishery/statistics/software/fishstatj/en. 

FishStatJ runs on Windows 7, 8 and 10 (64-bit only). It requires Java 8 to be installed on the 

computer http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-

2133155.html (the Installer is called Windows x64 Offline). FishStatJ requires at least 4GB of 

RAM. 

To install on Windows, the ZIP-download must be extracted into a directory where the user has 

update permissions. We recommend to unzip the program to the C-disk (C:\FishStatJ) or leave the 

unzipped FishStatJ folder on the Desktop. 

It is very important when extracting to maintain the zipped file structure; with all the 

required FishStatJ subdirectories!  

The first step is to extract (copy) the content of ZIP file into the root folder of the C: disk, or extract 

onto the Desktop: 

 

Note: To extract files into C:\ProgramFiles\ requires Administrator permissions. 

 

Then, run FishStatJ from the extracted folder: 

 

The next step after expanding the application ZIP file is to download workspaces; please refer to 

“Browse Workspace …” in chapter 2.1. 

http://www.fao.org/fishery/statistics/software/fishstatj/en
http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html
http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html
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If you cannot run 64-bit applications, you can continue to use FishStatJ 3.02. Contact us (refer to 

chapter 8.6) if you wish to download this version. 

Create a shortcut on the Desktop 

To create a shortcut on the Desktop, select FishStatJ.exe and drag it onto the Desktop while holding 

the [CTRL] and [SHIFT] keys (when simultaneously holding down both keys the mouse pointer 

changes into shortcut arrow): 

 

Applications can be added to the task-bar (usually on the bottom of the screen); by right-clicking on 

the icon in the task-bar while the application is running: select “Pin this program to taskbar”. 

1.2.1 Windows troubleshooting (companion library) 

If you receive the message: “The FishStatJ executable launcher was unable to locate its companion 

shared library”, this happens when FishStatJ was run from inside the ZIP file; the solution is to 

extract the ZIP file content as described above. 

1.2.2 Windows troubleshooting (Java tips) 

 You can download the Version 1.8 JRE from the URL in chapter 1.2 Installing on Windows. 

 To un-install a previous version of Java, follow these instructions: 

https://www.java.com/en/download/help/uninstall_java.xml.  

 For troubleshooting the Java version, check that the JRE was added to the PATH, and that 

the JAVA_HOME environment variable is pointing to the JRE installed. One can verify 

these settings, by running the command “java –version” from a DOS window. 

https://www.java.com/en/download/help/uninstall_java.xml


FishStatJ Manual 

Version 3.03 
July 2017 

 

Page 7 of 74 

1.2.3 Windows troubleshooting (No Java Environment available) 

 
The solution is to install Java JRE (refer to Java tips above) 

 

1.2.4 Windows troubleshooting (Wrong version Java) 

 
To have the correct version activated, we suggest to un-install the older Java JRE, then re-install 

Java 1.8 JRE (refer to Java tips above). 

1.2.5 Windows troubleshooting (failed to load jvm.dll) 

If you receive the message: “Failed to load JNI shared library vml.dll”; the Java run-time installed 

and activated is 32-bit; FishStatJ requires 64-bit Java run-time.  

 

The solution is to install JRE 1.8 64-bit (refer to Java tips above); the 32-bit JRE can remain 

installed on the computer. 
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1.2.6 Windows 10 (allow unknown publisher) 

 

When launching FishStatJ.exe on Windows10; a dialog appears informing the software is from an 

unknown publisher. Please select “Yes” to continue launching the application. 
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1.3. Installing on MacOS 

Download the OSX application http://www.fao.org/fishery/statistics/software/fishstatj/en. After 

extracting, the FishStatJ application can be directly run from the Desktop, or moved to the 

Applications folder. It requires at least 4GB of RAM. 

FishStatJ runs on OSX 10.9, 10.10 and 10.11. It requires Java 8 to be installed on the computer 

http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html. 

As FishStatJ is an application which is downloaded from the FAO web-site; the OSX security needs 

to be adjusted in System Preferences -> Security & Privacy in order to allow applications from 

identified developers: 

 

 

The next step is to download workspaces; please refer to “Browse Workspace …” in chapter 2.1. 

 

http://www.fao.org/fishery/statistics/software/fishstatj/en
http://www.oracle.com/technetwork/java/javase/downloads/jre8-downloads-2133155.html
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1.3.1 MacOS troubleshooting: 

If you receive the message: “Out of memory”, when you open a dataset, this happens when the Java 

Runtime was migrated from an older macOS version; and is not updated. You can check the Java 

version installed using Terminal “java –version”.  

We recommend Java 1.8 (Java8); this is the version against which we test the application. We found 

that to update from Java 1.6, you need to install the JDK 1.8: 

http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html 

http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
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1.4. Workspaces (statistical data) 

Workspace files carry the statistical data. While there is no limit how many workspaces can be 

installed on a computer, FishStatJ can only work with one workspace at a time. 

A workspace can contain one or more datasets. For dissemination of data, workspaces are 

compressed into workspace files (.wks extension); they are downloaded automatically by FishStatJ. 

We currently offers 4 different workspaces files, which contain the following datasets: 

 The Global Production workspace which contains: 

o Global Production 

o Capture Production 

o Aquaculture Production 

 The Regional workspace with contains: 

o CECAF (Eastern Central Atlantic) 

o GFCM (Mediterranean and Black Sea) 

o RECOFI capture production 

o SEATL Southeast Atlantic Capture Production 

 The Food Balance workspace which contains: 

o Food Balance Sheet 

o Population data  

 The Commodities workspace which contains: 

o Fisheries Commodities Production and Trade  

Please refer to Browse workspace... (below) for importing workspaces into FishStatJ. 
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2.  Dataset Menu 
2.1. Browse workspace... 

The browse workspace menu allows to manage the workspaces: 

 Open workspaces already installed 

 Download and install workspaces (from the FAO web-page) 

 Delete workspaces installed on the computer 
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The workspace browser shows two kind of workspaces: 

 Workspaces in red color, are not installed on the computer (also if there is a new version 

available) 

 Workspaces in blue color are installed on the computer 

 

Example of a workspace data version 2016.1.0 installed on the computer 

 

An installed workspace can be opened for viewing the data, or deleted (removed) from the 

computer. 

Manually download workspaces can be imported using the Import button. 

Workspaces already installed, are not be shown as available for download. 
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2.1.1 Installing a new workspace (download) 

Example of a new updated version of an already installed workspace is available for download: 

 

 

Clicking on the download button will open the workspace import wizard: 
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A progress bar appears during the download 
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In case an older version of the data is already installed, FishStatJ will ask if the new version should 

overwrite the old version – or keep both (resulting in two versions of the same data installed). 
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During the workspace installation progress is shown: 

 

When the installation is complete 

 

 

The workspace file which is downloaded on the Desktop can be deleted after importing. 

 

After clicking on Finish, the workspace browser opens (refer to “Open dataset…”) below. 
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2.1.2  Browse workspace (delete) 

This will show the workspace browser dialog; which allows you to manage the workspaces 

installed on your computer: 

 

Selecting a workspace will show metadata for this particular workspace (Acronym, Version, Name, 

Description, Provider, and location on disk). The selected workspace is permanently removed from 

your computer when you click on the Delete button. 

 

2.1.3 Browse workspace (import) 

The “Import…” buttons allows to import manually downloaded workspaces. 

 

Normally, workspaces are downloaded by FishStatJ, so there is no need to manually download a 

workspace file. 
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2.2. Open Dataset... 

NOTE: This option is only available if a workspace has already been opened  

 

Selecting this option will present the Dataset selection popup window where datasets may be 

opened and brought into FishStatJ for viewing. 

 

Once you have opened a dataset, the Open workspace menu is disabled (will disappear); until you 

Close the active workspace 

 

Selecting a dataset with mouse clicks will present the relevant metadata. Select a dataset and click 

on the 'OK' button to open the dataset content. 
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When a dataset is opened, the screen looks like this: 

 

Highlighting a row (as shown above) will present the yearly data values below (as shown under the 

Measures tab) 
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2.3. Close workspace 

 
 

Selecting this option will close the current workspace and all datasets and that are active within this 

workspace.  

 

Note: Close workspace will record all active datasets, so they are automatically re-opened next time 

you launch FishStatJ. If you don’t want a dataset to be recorded as open, just close it using the close 

box on the dataset panel: 

 
 

Note: Filtering and Aggregation settings are also recorded for each dataset; and automatically re-

applied when you launch FishStatJ next time. 

 

If 'Save working session on exit' in the Preferences (submenu item under Tools) is selected, the 

datasets that were open when the Exit was selected will be automatically reloaded when FishStatJ 

restarts 
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2.4. Exit 

 

Selecting this option will exit the FishStatJ program.  
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3.  Edit Menu 
3.1. Copy selection 

 

Selecting this option will copy all selected rows into the clipboard. When the copy of the selected 

records into the clipboard is complete, a confirmation message such as this will appear: 
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3.2. Save selection (*.csv file)... 

 

Selecting this option will save all selected rows into a *.csv file. A 'Save as' pop-up will appear so 

that all selected rows may be saved into a *.csv file onto the hard drive where desired 
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When the save of the selected records into a *.csv file is complete, a confirmation message such as 

this will appear: 

 
 

The settings for exporting CSV files can be changed in the Preferences -> Data Export (explained in 

this manual in chapter 6.2). 
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4. Data Menu 
4.1. Filter... 

The timeseries filter becomes enabled once a dataset is open. Filter can be accessed from the Data 

Menu 

 

 
 

 

And from the toolbar by opening the filter icon: 
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Selecting Filter, will present the time series filter: 

 

On the left side are references included (data is shown), on the left side the references excluded (no 

data is shown). By default the Include side is empty; which means all references are shown. 

References available for filtering depend on the dimensions of the dataset loaded. In the example 

above, available filters are Country, Species and Fishing area. In this example only data for 

Australia is selected. 

Clicking OK will refresh the data display and activate the filter. 

The arrow buttons copy the selected reference object(s) from left-to-right or from right-to-left; 

according to the direction of the buttons: 

 

The double-arrows copy all reference objects in the direction indicated: 
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When using right-click; quick selections are possible: 

 Select all 

 Deselect all 

 Invert selection 

 

 Choose attribute allows to select the attribute used for the Filter dialog. This setting is 

remembered by FishStatJ. 

 Details on shows details on the selected reference object 
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4.2. Aggregate 

Aggregate is available once a dataset is open. It can be accessed from the Data meu: 

 
 

Or from the aggregate icon in the dataset toolbar: 

 

Selecting this option will present the Time series aggregation popup shown here: 

 
Aggregation setting are memorized for each dataset by FishStatJ. 
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On the Time series aggregation popup, aggregation selections deepened on the dimensions of the 

dataset.  

When selecting Grouped, it is possible to select the grouping (including Handpicked aka custom 

grouping). 

 

As an example, grouping a data element Continent (within Country); while aggregating Species and 

Fishing area, produces the following result: 
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4.3. Top/Other... 

 

Selecting this submenu item presents the Top/Other selection popup window 
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As an example, selecting the top 15 entries for a year (i.e. 1950) as shown here: 

 

Produces the result shown on the next page 
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4.4. Advanced sort... 

 

Selecting this submenu item presents the Advanced sort popup window where the dataset key 

elements may be included within the sort or excluded from the sort. Additionally, the sort ordering 

(i.e. ascending or descending) may be selected for each key dataset element 
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For example, sorting the Species element with a descending order produces the following result: 

 

Produces the result shown on the next page 
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5. View Menu 
5.1. Columns... 
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Selecting this option will allow the user to change the columns (attributes) that are displayed of the 

dataset. When the option is selected, the Preferences popup window is displayed as shown here: 

 

Note: For species, when the common name is not available, the scientific name will be shown 

instead. 
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The Dimensions used for the data display can be changed by selecting Concept: 

 

The Attribute can be chosen: 

 
 

Example: for the Concept Species, the common name used for display can be replaced with the 

Scientific name. 
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The Periods displayed may be changed as shown here: 
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5.2. Calculated columns... 

 

Selecting this option will allow the user to create calculated columns that are built from the original 

dataset columns. When the option is selected, the Preferences popup window where the user can 

create or edit calculated columns is displayed as shown here: 
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Calculated columns may be created (New...) or edited (Edit...) that produce the Calculated 

columns definition popup 
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Many statistical functions are available for calculated columns as shown here: 
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When a calculated column is created, it is shown at the end of the time-series as shown here: 
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5.3. Reports... 

 

Selecting this option will allow the user to create reports about the dataset that is 'active'. When this 

option is selected, the Report wizard is presented. 
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Reports are generated in PDF format. 
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5.4. Charts... 

We apologize the chart function is deprecated (not supported any more); as the level of detail has 

increased so that the program to produce the graph often does not produce meaningful results. By 

design charting works best with less than 10 items. 

 

We suggest to export the data and produce charts using Excel (or Numbers on MacOS) for example. 
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5.5. Show details 
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Selecting or deselecting this option will turn on or off the detailed information that is displayed at 

the bottom of the FishStatJ main display. This option allows more or less records of the time-series 

to be displayed. In the image above, the details are turned on where Measures are presented. 

Deselecting this option will remove the 'details' shown at the bottom of the FishStatJ main display. 

In this image, the details are not displayed: 
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5.6. Grand totals 

 

Selecting this option will create 2 (two) additional tabs in the FishStatJ display that show grand 

totals for the time-series. 
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One tab will be for Quantity (tonnes) as shown here: 

 

The 2nd tab will be for Quantity (number) as shown here: 
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5.7. Show metadata... 

 

Selecting this option will display the metadata about the time-series that is selected within 

FishStatJ. The metadata icon from the toolbar can also be used: 

 

An example of the metadata presented is: 
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5.8. Dataset citation/map/notes 

 

The three icons, in the order from left to right, do open: 

 Dataset citation (citation icon) 

 Dataset map (map icon) 

 Dataset notes (notes icon) 

These icon are only shown; if the citation/map/notes have been defined for the dataset. 

An example of the dataset notes dialog: 
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6. Tools Menu 

 

6.1. Custom groups 

Note: The Custom groups menu is only available when a dataset is open. 
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Custom groups are pre-defined for some time-series elements. The above screen shows the custom 

groups for Country while the image below shows custom groups that already defined for Species 

 

When a new custom group is to be created with the New... button, the New custom group 

definition popup is presented. 
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When an existing custom group requires editing with the Edit... button, the New custom group 

definition popup is presented with the existing group members listed in the Include field. 

A “Custom group name” and “Custom group description” can be entered in the dialog box; as a 

minimum the English field should be filled. 

If the data needs to be filtered – for example only a number of countries or species – then the Filter 

dialog is the solution (filter settings are saved and can be changed). If the user needs to analyse 

several groups of countries (or species, or catch areas) repeatedly, then custom groups are useful 

because they allow selections (custom groups) to be saved and re-used. 
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6.2. Preferences 

6.2.1 Preferences - General preferences 

 

Here, the user may specify preferences on General preferences, Data display, Data export and 

Languages. 
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6.2.2 Preferences – Data display 
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6.2.3 Preferences – Format highlights 

 

Formatting options control how data symbols are shown (set color and symbol display); the 

formatting is used for display and when exporting data. 
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6.2.4 Preferences – Format numbers 
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6.2.5 Preferences – Data export 

 

 Export table headers: when selected, headers are exported 

 Split values and symbols in two columns 

 Don’t export symbols 

 Export totals on all rows selected 

 Export citation 

 

 Re-adjust the preferences: will show the panel before each export operation to allow 

different settings  
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6.3. Help – Manual 

Automatically downloads the FishStatJ manual and opens it; the manual is a PDF (portable 

document format) file. 

 

 Windows requires Acrobat Reader to open PDF documents 

 macOS can open PDF documents using the Preview application 

 

The manual is downloaded to the workspace folder (refer to chapter 8.4 for more details). 

6.4. Key Assist 

Selecting this option will display a popup listing the shortcut keys to maximize efficiency in using 

FishStatJ. The popup with the key shortcuts is shown here 
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6.5. About FishStatJ 

 

Selecting this option will present the official FishStatJ information about version, legal use, 

development team and contacts for assistance. An example is: 
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7. Frequently asked questions (FAQ) 
7.1. What does that symbol mean? 

FishStatJ uses the following symbols for statistical data: 

... Data not available; unobtainable;  

Data not separately available but included in another category  

- Nil or zero  

0 More than zero but less than half the unit used  

F FAO estimate from available sources of information  

 

Nei means “Not elsewhere included”. 

 

In FishStatJ, you can configure the color of the symbols in the panel:   

Tools->Preferences-> Data Display->Format highlights (refer to chapter 6.2.3). 

 

As for data and symbol export to Excel, please be informed that you can configure how data and 

symbols are exported (or not exported) in  

Tools->Preferences-> Data export .csv and clipboard. 

“Don’t export symbols” is one of the options you can select (refer to chapter 6.2.5). 

7.2. Why is the grand total in FishStatJ different from the 

number published in the FAO yearbook? 

Trying to cover all products derived from fisheries activities, in both inland and marine waters, the 

FAO Fishery production datasets (capture and aquaculture),  include some products which are not 

(or not directly) destined to food consumption, such as marine mammals, crocodiles, corals, pearls, 

mother-of-pearl, sponges and aquatic plants. Those products are excluded from the all country, 

regional and world totals presented in FAO Yearbooks of Fishery Statistics as well as other FAO 

publications. 

 

When viewing time-series data in FISHSTAT, in order to obtain the same aggregates you must first 

filter the dataset using a Custom Group: 

1. Open the Filter Dialog Box (Data->Filter or F4) 

2. Click the <Species> tab 

3. Click the Groups combo box and select <Custom Group> 

4. Click <Fish, crustaceans, molluscs, etc.> 

5. Click the single left arrow in order to move under the "Include" left panel all selected species 

belonging to <Fish, crustaceans, molluscs, etc. (see picture below) 

6. Click <OK>. The program will return you to the Main Window. 

 

The aggregation grouping for capture and aquaculture datasets is mentioned in the dataset notes 

where applicable. Access to dataset notes is explained in chapter 5.8. 
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7.3. How to export data? 

You can EXPORT data from FishStatJ in two different ways:  

 

 You can simply copy a selection of rows and paste it on an Excel file (with the right button 

menu or with the Ctrl+C shortcut). 

 Or you can  

 The second way will allow you to choose between few export options.  You can configure 

how data and symbols are exported (or not exported) in Tools->Preferences-> Data export 

.csv and clipboard 

7.4. How often is the data/application updated? 

We publish new data as soon as we receive the complete set from member countries and have 

completed our verification. Usually, datasets are updated once per year. The release time for Global 

Capture and Aquaculture Production is in the second quarter every year. 

 

New or updated Datasets will automatically show in the Browse workspace menu; refer to chapter 

2.1 for a detailed explanation. 

 

When the FishStatJ application is launched, it will also check – and inform if there is a new version 

available for download; refer to chapter 8.5 for the auto-update notification. 

 

Data update/revisions are explained in chapter 8.3. 

7.5. How does FAO assign nationality to catches? 

As established by the United Nations Statistical Commission in 1954, catches are assigned to the 

country of the flag flown by the fishing vessel. The flag State is also responsible for the provision of 

the relevant data to FAO and other organizations such as Regional Fishery Bodies (RFBs). 

7.6. Prior year numbers have changed. Why? 

Refer to chapter 8.3 for a discussion on data versions. 

7.7. Where to find detailed notes for each dataset? 

Additional information about the statistics presented in each dataset collection are available in the 

General notes, accessible in the Menu/View/Metadata/Attachments/#dataset – general notes (or by 

clicking on top right button of data panel. 

 

Refer to chapter 5.8Error! Reference source not found. for viewing dataset notes. 
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7.8. FishStatJ is being flagged as a virus threat 

There have received various reports that FishStatJ software has been falsely identified as being a 

virus threat. We try very hard to produce FishStatJ, and we would not knowingly distribute an 

infected version. 

 

Wikipedia defines a false-positive as a false alarm 

https://en.wikipedia.org/wiki/False_positives_and_false_negatives. 

 

If you receive such alert, we suggest the following actions, in the following order: 

 Please send us an e-mail (Fish-Statistics-Inquiries@fao.org), describing the anti-virus 

software used, and the alert message received (this way we can double-check your 

download, and also warn other users). 

 Please inform you virus software vendor and notify them of the ‘false positive’ indication.  

The vendor can then quickly investigate (check our download) and release an update to their 

virus definitions (definitions are patterns to detect infected software). 

 If you think FishStatJ is corrupted, the best is to re-download and expand a fresh copy. 

 

NEVER - consider deactivating your virus protection because that would be irresponsible in this 

digital age! 

 

The MacOS version is digitally signed, as such will not launch when tampered. This provides an 

additional layer of security (refer to chapter 1.3 for Mac security). 

https://en.wikipedia.org/wiki/False_positives_and_false_negatives
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8. More on FishStatJ 
8.1. FishStatJ legal specifications 

The FishStatJ software is provided free of charge to member countries of the Food and Agriculture 

Organization (FAO). It may be installed on personal or company computers without restriction or 

license. The statistics contained in this package may be used and published freely provided that 

the source is cited as FAO. 

8.2. Bibliographic citation 

FAO encourages the use, reproduction and dissemination of material in this information product. 

Except where otherwise indicated, material may be copied, downloaded and printed for private 

study, research and teaching purposes, or for use in non-commercial products or services, provided 

that appropriate acknowledgement of FAO as the source and copyright holder is given and that 

FAO’s endorsement of users’ views, products or services is not implied in any way. 

All requests for translation and adaptation rights, and for resale and other commercial use rights 

should be made via www.fao.org/contact-us/licence-request or addressed to copyright@fao.org. 

When quoting FishStatJ data, please use the reference that you can find in the General Notes 

attached to each dataset (FishStatJ menu: View/Show metadata/Attachments).  

The citation for each dataset is available for copy/paste under the citation icon: 

 

The bibliographic citation for FishStatJ is as following: 

FAO Fisheries and Aquaculture Department, Statistics and Information Service 

FishStatJ: Universal software for fishery statistical time series. Copyright 2017. 
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8.3. Data versioning and Data revisions 

Where necessary the data published in the previous releases of the dataset(s) of fishery and 

aquaculture statistics are revised. 

 

Where figures in this release differ from those previously published, the amended data represent the 

most recent version. Some statistics provided to FAO by national offices, in particular those for 

most recent year, are provisional and may be amended in future editions. 

 

The version and revision of the data installed, and version/revision of data available for download 

are visible in the Browse workspace menu; refer to chapter 2.1. 

 

For example the version is “2017.1.0” 

 

Major version: is the year when the data was released (2017) 

Minor version: is the release (1) and revision number (0) 

 

Occasionally, we find errors, or we receive data from member countries after the release of the 

FishStatJ workspace. In these rare cases, we release a new revision of the data by increasing the 

revision number. This way, the new version is automatically visible in the workspace browser as a 

new download. In this case, we would also include an explanation in the dataset notes; refer to 

chapter 5.8 how to view dataset notes. 

 

8.4. Un-installing FishStatJ 

FishStatJ is un-installed by deleting the FishStatJ application folder (macOS: the application icon). 

FishStatJ stores imported workspaces (and application files) in the user home directory; these can 

be deleted as well: 

 For Windows enter %USERPROFILE%/fishstatj_workspace in the Run menu 

 For OSX Finder enter ~/fishstatj_workspace in Go->Go to Folder menu 

FishStatJ is a cross-platform application and therefore does not use the Windows-registry, it stores 

all data and settings in the user home directory as described above. 
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8.5. FishStatJ Auto-update 

Starting with version 3.01 FishStatJ has automatic update capability built in. At program launch a 

very small file (~1KB) is read from the FAO web-site (http://www.fao.org). If there is no internet 

connection, auto update is disabled gracefully – the notification of a new program version is not 

available, and no workspaces are shown for automatic download. 

If there are updated workspaces available, they will automatically appear; please refer to  Browse 

workspace. 

 

When we release a new version of FishStatJ, you will see the following message at program startup: 

 

Clicking the Yes button will open the FishStatJ web-page in the web-browser where program 

updates can be downloaded. 

8.6. Assistance and Contact 

On the FishStatJ web-page (http://www.fao.org/fishery/statistics/software/fishstatj/en) you can find 

 New program versions for download 

 A quick-start guide for installing the program 

 The download link to this manual 

 The e-mail contact for support (Fish-Statistics-Inquiries@fao.org) 

 

 

 

http://www.fao.org/
http://www.fao.org/fishery/statistics/software/fishstatj/en

	1.1.  What is FishStatJ
	1.2.  Installing on Windows
	Create a shortcut on the Desktop
	1.2.1 Windows troubleshooting (companion library)
	1.2.2 Windows troubleshooting (Java tips)
	1.2.3 Windows troubleshooting (No Java Environment available)
	1.2.4 Windows troubleshooting (Wrong version Java)
	1.2.5 Windows troubleshooting (failed to load jvm.dll)
	1.2.6 Windows 10 (allow unknown publisher)

	1.3.  Installing on MacOS
	1.3.1 MacOS troubleshooting:

	1.4. Workspaces (statistical data)
	2.  Dataset Menu
	2.1. Browse workspace...
	2.1.1 Installing a new workspace (download)
	2.1.2   Browse workspace (delete)
	2.1.3 Browse workspace (import)

	2.2. Open Dataset...
	2.3.  Close workspace
	2.4. Exit

	3.   Edit Menu
	3.1. Copy selection
	3.2.  Save selection (*.csv file)...

	4.  Data Menu
	4.1. Filter...
	4.2.  Aggregate
	4.3.  Top/Other...
	4.4.  Advanced sort...

	5.  View Menu
	5.1. Columns...
	5.2.  Calculated columns...
	5.3.  Reports...
	5.4.  Charts...
	5.5.  Show details
	5.6.  Grand totals
	5.7.  Show metadata...
	5.8.  Dataset citation/map/notes

	6. Tools Menu
	6.1. Custom groups
	6.2.  Preferences
	6.2.1 Preferences - General preferences
	6.2.2  Preferences – Data display
	6.2.3  Preferences – Format highlights
	6.2.4 Preferences – Format numbers
	6.2.5  Preferences – Data export

	6.3. Help – Manual
	6.4. Key Assist
	6.5.  About FishStatJ

	7. Frequently asked questions (FAQ)
	7.1. What does that symbol mean?
	7.2. Why is the grand total in FishStatJ different from the number published in the FAO yearbook?
	7.3. How to export data?
	7.4. How often is the data/application updated?
	7.5. How does FAO assign nationality to catches?
	7.6. Prior year numbers have changed. Why?
	7.7. Where to find detailed notes for each dataset?
	7.8. FishStatJ is being flagged as a virus threat

	8. More on FishStatJ
	8.1. FishStatJ legal specifications
	8.2. Bibliographic citation
	8.3.  Data versioning and Data revisions
	8.4. Un-installing FishStatJ
	8.5.  FishStatJ Auto-update
	8.6. Assistance and Contact


